Welcome to Value Line Investment Analyzer. This user guide will show you everything you need to know to access and utilize the wealth of information available from Value Line.

The Value Line Investment Analyzer program is a CD-ROM-based database that is installed on a local workstation computer in the McLeod Business Library. This is the only computer with access to this program. Please contact a member of the Business Library staff for assistance in locating this workstation.

Introduction

The Value Line Investment Analyzer contains information on approximately 1,700 stocks, more than 90 industries, the stock market, and the economy. Similar to the printed Value Line Investment Survey, this electronic program has three main sections:

Summary & Index contains an index of all stocks in the database as well as many up-to-date statistics. It also contains a variety of stock “screens” designed to identify companies with various characteristics.

Ratings & Reports have one-page reports for each company in the database. Each company report includes Value Line’s Timeliness, Safety, and Technical ranks, financial and stock price forecasts for the coming 3 to 5 years, and an analyst’s written commentary.

Selection & Opinion is a weekly newsletter that contains Value Line’s latest economic and stock market forecasts, write-ups of interesting and attractive stocks, model portfolios, and financial and stock market statistics.
Table of Contents

Introduction ............................................................................................................................... 1
Table of Contents ...................................................................................................................... 2
Overview ................................................................................................................................... 3
Getting Started .......................................................................................................................... 4
The Opening Screen .................................................................................................................. 5
What’s New .............................................................................................................................. 6
Summary & Index ....................................................................................................................... 7
  Summary & Index Toolbar ....................................................................................................... 8
  Using the Summary & Index Database .................................................................................. 12
    Company Page ...................................................................................................................... 12
    Working With Lists ............................................................................................................. 13
    Working With Filters ........................................................................................................... 14
    Working With Charts & Graphs ......................................................................................... 15
Ratings & Reports ...................................................................................................................... 16
Selection & Opinion .................................................................................................................. 18
Technical Analysis .................................................................................................................... 19
Portfolio Management .............................................................................................................. 20
Go to the Web ............................................................................................................................ 22
Update ..................................................................................................................................... 23
Market Commentary .................................................................................................................. 24
Streaming Real-Time News ...................................................................................................... 25
User’s Manual ........................................................................................................................... 26
Online Tutorial ........................................................................................................................... 27
Overview

The *Value Line Investment Analyzer* offers various options to start using the program’s databases. These options are:

- **What’s New**: A look at recent stocks, earnings, and companies that have moved in their ranking. (See page 6.)
- **Summary & Index**: A full database listing of all companies Value Line follows with latest price, rankings and other key data. (See page 7.)
- **Ratings & Reports**: Full-page stock profile reports, with about 130 reports updated each week. (See page 16.)
- **Selection & Opinion**: A weekly newsletter. (See page 18.)
- **Technical Analysis**: Blends ability to perform both fundamental and technical analysis within an integrated financial research environment. (See page 19.)
- **Portfolio Management**: The Portfolio Manager allows you to create a portfolio and track its progress. (See page 20.)
- **Go to the Web**: An integrated web browser. (See page 22.)
- **Update**: Allows you to get the most recent updates for the *Value Line Investment Analyzer* program. (See page 23.)
- **Market Commentary**: This selection provides a short market analysis prepared by senior Value Line analysts. (See page 24.)
- **Streaming Real-Time News**: This page offers current stories, which are updated very frequently (every few minutes when news is breaking). (See page 25.)
- **User’s Manual**: The User’s Manual is an electronic manual to allow the user to fully use all the functions available. (See page 26.)

There is also an online tutorial included. You can access the tutorial by clicking on *Help* in the menu bar and selecting **Online Tutorial**. (See page 27.)
Getting Started

When the Value Line Investment Analyzer program is initiated you will see the Value Line Logon window. Click on the Connect button to access the on-line database. If you do not have a password already entered in the Password box, please contact a Business Library staff member to have the password entered for you.

When the opening screen is displayed, there will usually be a window opened in the main section of the screen. It may be either a Tip of the Day or Coming Soon . . . window. This window must be closed before you can use the database. Click on the OK or Close button to close this window.
The Opening Screen

The opening screen of the *Value Line Investment Analyzer* consists of three sections.

1. The top section includes the menus and toolbars.
2. The section on the left, **Select Task**, has the icons and descriptions of the options available to access the databases. It also includes the Market Commentary, Streaming Real-Time News, and User’s Manual.
3. The main section on the right displays *Value Line Investment Analyzer* information when the program first opens. This is the area where all data and information is displayed.

Above. The opening screen showing the three sections of menus and toolbars, Select Task and the display area.

The bottom of this section has another bar with the words **Task Views**. Task Views shows all open functions so that you may switch between them without closing them. When you click on the **Task Views** bar any open functions are displayed in the section on the left as icons.

3. The main section on the right displays *Value Line Investment Analyzer* information when the program first opens. This is the area where all data and information is displayed.

Left. The Task Views screen showing four icons for open functions that you may select to display.
What’s New

The What’s New option allows you to identify stock splits, earnings data and companies that have recently moved up or down in Value Line’s Timeliness Ranks.

To use the What’s New option click on the What’s New icon in the Select Task section of the screen. The What’s New page is then opened in the display area.

The following options are available in the What’s New display: This Week, Timeliness Rank, Stock Splits, Earnings, and Delisted. Each of these options is accessed by clicking on the button of the same name across the top of the What’s New display. When selected, each option will display a table of new information from the topic area.

The This Week selection is the default display when the What’s New option is first opened.
Summary & Index

Summary & Index contains the full database of companies included in Value Line.

1. To open Summary & Index, click on the Summary & Index icon in the Select Task section of the opening screen.

   • A small Summary & Index window will appear in the display area. The directory tree that is in the Summary & Index window can be expanded to show additional selections under each category. Click on the “+” inside the boxes and the directory under that heading will be expanded.

   • Highlight your selection by clicking on it with the mouse then click on the Display button in the Summary & Index window to open the database.

   • Leave the highlight on the Summary & Index line to open the complete database when the Display button is clicked.

2. Once you click on the Display button the selected database is opened in the display area.

   • You can go back to the Select Task section, click on Summary & Index and select another category to display. You may do this as many times as you need.

   • Each database you select will have an icon displayed in the Task Views window. You may then switch back and forth among your selected databases by using the Task Views window.

3. The Summary & Index window of the Value Line Investment Survey contains the following elements: (1) Title Bar, (2) Menu Bar, (3) the program toolbar, (4) the Summary & Index toolbar with the Find Box (“Type Company Name”) window, (5) Spreadsheet, and (6) Scroll Bars.
4. If the database that is displayed is not the complete database and you wanted the entire
database opened, click on the **Reset Ticker List** button.

A window with the message, “You have chosen to reset
your list to the Full Database. Do you wish to continue?”
Click on **Yes**.

5. Once you have opened a database, the Summary & Index view is similar to that of a
spreadsheet such as Microsoft Excel. All stocks are listed in a table of rows and columns.

6. You can scroll right and left, bringing additional columns into view, by clicking on the left
and right arrows at either end of the bottom scroll bar.
To move up and down through the grid, bringing additional stocks into view click on the
up and down arrows at either end of the vertical scroll bars.

**Summary & Index Toolbar**

The Summary & Index toolbar contains buttons for searching, sorting, filtering tools, charting
tools, Quick Filter and Quick View.

You may open the full database and, at the same time, explore more than 30 different Value
Line screens, companies organized in more than 90 specific industries, or international
companies. Use the **Task Views** icons to switch between the open databases.

Here are some key features you can operate from the toolbar:

1. **Navigation Tools – Find Box and Binoculars**
   - Use the **Find Box** to locate a company by entering the
     company name. The database scrolls as you type in each
     letter.
   - The **binocular** button – another quick search tool – locates a company, ticker symbol,
     or other information.

   When the **binocular** icon is clicked on, the **Search By Name** window appears. You
   may select search criteria in the **Search Where** box. The down arrow at the right
   side of the box opens a list of all the column headings in the database. Scroll down the
   list and select the heading you want (e.g., Cash) by clicking on the name. Next type
   what you are looking for in the **Find What** box (e.g., a word or a number, such as 25, if
   searching in the cash column.). You may select from three types of searches in the
   **Type of Search** box. The types of searches are: **Starts With**, **Exact Match**, and
   **Anywhere in Field**.
Click on the **Find First** button and the column moves to the first number that starts with the number entered (if **Starts With** was selected in the **Type of Search** data field). The **Find Next** button is clicked when you want to find the next value in the column that starts with the number entered. You can do this until you reach the end of the column.

2. **Sort Button – Ascending/Descending:** Any column on the spreadsheet can be sorted from top to bottom, or bottom to top, by double clicking on the column heading. Use the sort button for more advanced sorting of values by more than one field.

3. **Filters:** The **Filter** command helps to screen the database according to your own criteria and formulas. For example, you might only want to view companies whose growth is above a certain target and whose P/E and P/B meet other specifications. **Save** your filter for future use; and use the **Reset Filter** function to remove the filter and return to the full database. For more details on filters, see Working With Filters on page 14.

   Note: To save modified databases or lists choose **File** and **Save**. You will be prompted to give the new file a name in the **Save** window.

4. **Selecting Companies/Creating Lists:** Create and save lists of companies that you will reference frequently.

   To select stocks, place the cursor in the far left (numeric) box of the row until the cursor turns into a right-facing arrow and click on it with the mouse. Depress the **Control** (CTL) key on your keyboard to select additional stocks. Then select **File** from the menu bar and select **Save** to save the list of stocks you have highlighted, or **Open** a list you have created in the past. You might also create a **New** list, by re-opening the **Summary & Index** database.

   You may also use the **Edit Ticker List** and **Reset Ticker List** buttons. For more details on lists, see Working With Lists on page 13.

5. **Charts & Graphs:** Create charts and graphs to illustrate the performance of one or more stocks. Choose the **Charts** icon from the toolbar to open the **Charts** window that enables you to use more than 50 chart types and visualize hypothetical investments over custom time periods. **Save** and **Load** these charts for future reference and comparison. For more details on Charts & Graphs, see Working With Charts & Graphs on page 15.
6. Generating Statistical Overviews

First, either select a List you created or filter the database. You may then click on the Summary Statistics button to create a Statistics Report for those companies. This report may be saved or exported to your disk.

7. User-Defined Fields

The User-Defined Fields button allows you to create a formula to your own criteria for a user-defined column. The user-defined columns are displayed at the far right side of the display area (using the scroll bar).

Clicking on the User-Defined Fields button opens the User-Defined Fields window. Highlight the field you want to modify and click on the Create/Edit button.

This opens the User-Defined Field Editor window. You may change the name of the field name in the Field Name box.

Select the items you want by double clicking on the item in the Select From and Operator boxes. As you select items they appear in the Formula box.

Once a formula is entered you may check it by clicking on the Verify button or clear all your entries by clicking on the Clear button. The Calculate button will use the formula to create new data in the appropriate column in the display area of Value Line. When finished click on the Done button to close the User-Defined Field Editor window.

Click on the Close button to close the User-Defined Field window to return to Value Line.
8. The **Value Line Page** button is used to view the Ratings & Reports page for a selected stock. See page 16 for more information about Ratings & Reports.

9. **Quick View**: This icon helps refine the spreadsheet to one of more than 20 categories in business and investment. Clicking on the button, or the down arrow next to it, will open a list of categories available. Selecting one (e.g., Balance Sheet) will change the display in Summary & Index to include only those columns of information that pertains to balance sheets.

   You may modify the columns displayed even more by selecting **Customize Column Set** in the *View* menu. This will open the *Customize Column Set* window. This allows you to view only specific data.

   The window opens with all selections already displayed in the *Selected* box. The items in the *Selected* box match the titles of the columns currently displayed. If you have changed the category, only the columns in that category will be listed.

   You must remove unwanted selections by clicking on the **Hide** or **Hide All** buttons. Click on the +/- to expand or condense the choices in the *Select From* box. Highlight only those data fields you want to **Show** in the spreadsheet. You may **Save** your selections to your own floppy disk. Click on the **Load** button to display your modified database.
Using the Summary & Index Database

Once you have the full database, or the selected database you have chosen, displayed you may perform a number of operations on it to gain more information.

1. **You may find a company by either scrolling down the entire database or you can use the Find Box.**

   You locate a company using the **Find Box** by starting to type the company’s name in the box. As you type the database scrolls down to the letters you have typed.

2. **Once you have selected a company for further research you can access information about this company by clicking on the blue ticker symbol, which is a link to the company’s page.**

**Company page**

The company page opens with the **General** section of the company page on top. This page may be scrolled down to reveal that at the end of the business profile section there is a hyper-link to the company’s home page on the Internet, if it has one. You will notice that the Internet navigation tools just above the Select Task bar are activated while on the Internet.

Across the top of the company page there are a series of tabs that are used to select other sections of the company page. These tabs are **General**, **Balance Sheet**, **Income Statement**, **Historical**, **Earnings**, **Commentary**, **Supplement**, and **Fund Owners**.

To print the information on any of the sections of the company page click on the tab to display the desired information, click on **File** on the menu bar and select **Print** or click on the **Print** button in the program toolbar.
Working With Lists

Creating a List

There are two ways to choose stocks for a List. First, you can run a filter. (See Working With Filters on page 14.) Second, you can manually tag each company by clicking on the row number to the left of the name. After you have selected the first company, hold down the Control [CTL] key while clicking on additional companies. Once you have selected all the companies you want you can save them as a list.

To save the list to your disk, choose File and Save List. You will be prompted to give the new list a name in the Save Custom Ticker List dialog box.

Opening a List

To open a previously saved List choose File and Open List and you will be given a selection of saved Lists from which to choose.

Changing the Stocks in a List

To change the stocks in a List, open the list you want to edit and then click on the Edit Ticker List button or choose Ticker List from the Edit menu. The Edit Ticker List window will appear.

To remove a stock from the List, highlight it by clicking on it in the Currently Included in List box, then click on the Remove button. All stocks may be removed by clicking on the Remove All button.

To add stocks to the List, highlight the desired stock in the Currently Excluded From List box, then click on the Add button.

When finished, click on the Save button to save the list. The Save Custom Ticker List dialog window will appear and you will need to name the new list. If you want to keep the same name simply click on the name in the list and the name will appear in the File Name box. Click on the Save button when finished.

Printing the Spreadsheet

The List you have created may be printed by using the Print command from the File menu.

Generating Statistical Overviews

First, either select a List you created or filter the database. You may then click on the Summary Statistics button to create a Statistics Report for those companies. This report may be exported to your disk and saved or printed.
Working With Filters

Selecting Stocks Using a Filter Query

The Run a Filter button enables you to query the database for stocks that meet your specific criteria. When you click on the Run a Filter button, the Custom Filter window is opened.

Creating a Filter

Click on the red "<Choose a Field>" lettering in the Field Name column. A list of field categories appears. As you move the mouse cursor down the list a sub-list appears to the side. As you move the mouse cursor over the sub-lists, a description of what that field does is displayed. Click on the field you want and it appears in the Field Name column.

Then click on the box under the Logic header and a list of logic symbols (e.g., <, >, =, etc.) appears. Click on the symbol you want and it appears in the Logic column.

Next click on the Value column and a list of fields appears similar to that used in the Field Name column. Select the field you want and it appears in the Value column.

Finally click on the Run Filter button and the database is filtered according to your criteria.

Removing a Filter

To remove a filter and restore the full universe of stocks, click on the Reset Filter icon on the toolbar, or choose Reset Filter from the Tools menu.

Quick Filters

Quick Filters are predefined lists that can be used to quickly narrow the universe of stocks down to those of a specific industry or meeting a specific criteria, such as stocks in the Internet industry or Large Cap stocks.
Working With Charts & Graphs

Creating Charts & Graphs

The Summary & Index section of the *Value Line Investment Analyzer* allows you to view the data associated with one or more stocks in the form of charts and graphs. Clicking on the **Charts** button will open the **Charts** window.

You may select the stocks to evaluate by typing the name of the stock in the **Select From** box. The list below the box will scroll to the stock selected. To add this stock to the **Selected** box, click on the **Add** button. You may select up to ten stocks. If you change your mind and want to remove a stock from your list, highlight the stock to be removed in the **Selected** box and click on the **Remove** button.

Next select the type of chart from the **Chart Type** box. Click on the down arrow and a list of chart types will appear. As you run your mouse pointer down the list additional types will be displayed. To select the type of chart you want click on the name and it will appear in the **Chart Type** box.

Next select the style of chart in the **Chart Style** box. Click on the down arrow and a list of styles appears. Click on the style you want and it will appear in the **Chart Style** box.

You may also select what the chart will show by clicking on the desired selection in the **Show** box.

To display the chart, click on the **OK** button and a window will open with your chart in it.
Ratings & Reports

The Ratings & Reports section of the Value Line Investment Analyzer lets you access one-page stock reports. These reports can be enlarged, printed and searched for text strings.

To open a Ratings & Reports stock profile, click on the Ratings & Reports icon in the Select Task section of the opening screen. The Ratings & Reports window will open, where you can choose a company to view.

You can look up a company by name, ticker, industry, or Value Line Investment Survey issue.

Selecting by Company

To select by company name, click on the radio button next to “Name” in the right hand column and then in the box above the listing of names. Begin typing the name of the company you want. The list will scroll to the company as you type. When you reach the company you want to display, click on it to make sure it is highlighted, then click on Display. The report will appear in the display area.

Note: If a window appears after you click on Display stating that the program could not find the Value Line CD-ROM and asks if you wish to download the report from www.valueline.com, click on Yes.

Selecting by Ticker

To select a report by ticker symbol, click on the radio button next to “Ticker” in the right hand column. A list of tickers appears in the display box. In the space above the ticker listing begin typing in the ticker symbol and the list scrolls forward as you type. Highlight the ticker you want by clicking on it then click Display. The report will appear in the display area.

Selecting by Industry

To select by industry, click on the radio button next to “Industry” in the right hand column. A list of industries will then be available in the box below the word “Industry.” Click on the arrow next to the box and a list of industries will appear. Highlight the industry you want and a list of companies in that industry will appear in the display box. You can either type the company name in the box above the display box or scroll down the list. Select the desired company by clicking on it. Then choose Display. The report will appear in the display area.
Selecting by Issue

Choose Issue to display only those reports from a particular Rating & Reports edition. There are 13 editions of Ratings & Reports, published one per week over a 13-week cycle.

To select by issue, click on the radio button next to “Issue” in the right hand column. A list of issues, numbered from one through thirteen, will then be available in the box below the word “Issue.” Click on the arrow next to the box and the list of issues that are available will appear. Highlight the issue you want and a list of companies in that issue will appear in the display box. You can either type the company name in the box above the display box or scroll down the list. Select the desired company by clicking on it. Then choose Display. The report will appear in the display area.

Note: If a window appears after you click on Display stating that the program could not find the Value Line CD-ROM and asks if you wish to download the report from www.valueline.com, click on Yes.
Selection & Opinion

The Selection & Opinion option is the weekly newsletter component of the Value Line Investment Analyzer.

To view Selection & Opinion, click on the Selection & Opinion icon in the Select Task section of the opening screen. The Selection & Opinion window will open. It is not necessary to make a selection from the directory tree displayed in the window. Click on the Display button to bring the Selection & Opinion page into the display area. Select the issue you wish to view, either the current issue or select one from the archives.

The Selection & Opinion display is then opened in the display area using Adobe Acrobat. The Adobe Acrobat controls are included in the display area. The button bar across the top includes information about the document (e.g., page number) and various manipulation controls, including buttons to control the forward and backward turning of pages.
Technical Analysis

The Technical Analysis section of the Value Line Investment Analyzer lets you choose companies to analyze.

To choose a company, click on the Technical Analysis icon in the Select Task section of the opening screen. The Choose a Security window will open where you can choose a company. You can look up a company by name, ticker or industry.

You also have the choice to select the source of the information, whether local or Internet. Click on the radio button next to your choice. The list of companies available for analysis changes depending on the source selected. The list for the local source is limited compared to the Internet source.

Selecting by Company

To select by company name, click on the radio button next to “Name” in the right hand column and then in the box above the listing of names. Begin typing the name of the company you want. The list will scroll to the company as you type. When you reach the company you want to display, click on it to make sure it is highlighted, then click on Display. The report will appear in the display area.

Selecting by Ticker

To select a report by ticker symbol, click on the radio button next to “Ticker” in the right hand column. A list of tickers appears in the display box. In the space above the ticker listing begin typing in the ticker symbol and the list scrolls forward as you type. Highlight the ticker you want by clicking on it then click Display. The report will appear in the display area.

Selecting by Industry

To select by industry, click on the radio button next to “Industry” in the right hand column. A list of industries will then be available in the box below the word “Industry.” Click on the arrow next to the box and a list of industries will appear. Highlight the industry you want and a list of companies in that industry will appear in the display box. You can either type the company name in the box above the display box or scroll down the list. Select the desired company by clicking on it. Then choose Display. The report will appear in the display area.
Portfolio Management

The Portfolio Management section of the Value Line Investment Analyzer allows you to create a portfolio and track its progress. Be aware that this program is installed on a public access computer and all patrons will have access to any portfolios and may alter them or delete them.

To begin using the Portfolio Management feature click on the Portfolio Management icon in the Select Task section. This will display any portfolios that have been created in the main display area.

If no portfolios have been created the New Account window will be opened so you may create a portfolio. This window gives you four selections to pick an account type. These are: Regular Account, Value Line Model Portfolio, Import Existing Account, and Open a Saved Portfolio.

Select an option by clicking on the radio button next to the one you want and click on the Next button.

**Regular Account**

The Regular Account selection will open another New Account window. This one has a box where you may name the account and allows you to specify a beginning dollar amount.

Clicking on the Next button in this window will open the Record a Transaction window. You use this window to add items to your account. Enter the ticker symbol, quantity and share price amount. Select the type and transaction from drop down menus. When you have finished click on the OK button to add the item to your account and close the window.

The new account will be displayed in the main part of the Value Line screen.

If you want to add more than one new item click on the Record Another button. This will add the first item to your account but keep the window open so you may enter new data for another item. You may do this as many times as you need.

**Value Line Model Portfolio**

The Value Line Model Portfolio selection will open the Create Model Account window. This window has a box listing three model portfolios. Selecting one of these will add that account to the portfolio displayed. The User List selection will open the Open Custom Ticker List window where you may select a previously created list, if any had been created.
Clicking on the **Open** button will close that window. The Setup Options section of the **Create Model Account** window will be activated and you may enter a beginning dollar amount.

Click on the **OK** button to add the new account to the portfolio and close the window.

**Import Existing Account**

The Import Existing Account selection will open the **Import Existing Portfolio** window. This window has three selections for different types of files to import. The files must have been previously created and stored where the program can find it.

Select the item you want and click on the **OK** button. The program may not be able to locate a file of the type you wanted.

**Open a Saved Portfolio**

The Open a Saved Portfolio selection will open the **Restore Portfolio** window. This window will list any previously saved portfolios, if any have been saved. Select on the one you want to open and click on the **Open** button. This will add the selected portfolio to the list in the display area of the screen.

**Portfolio Display**

Once a portfolio has been created it is displayed in the main part of the Value Line screen. Each account in the portfolio is listed in its own section. The total portfolio value is listed at the bottom of the list.

**Portfolio Content Menu**

To perform actions on your portfolio click on the list using the right mouse button. This will display the Content Menu. This menu has selections for adding new items to an account (**Record a Buy**), adding a new account (**New Account**), or selecting preferences or account details. You also may delete an account or the entire portfolio.
Go to the Web

The Go to the Web option allows you to visit the Value Line website. You can download new information, check quotes / news and read daily Value Line articles on the markets.

To use the Go to the Web option click on the Go to the Web icon in the Select Task section of the screen. The web page display is then opened in the display area. The active web window of the Value Line web site contains the following elements: (1) Title bar, (2) menu bar, (3) the program toolbar, (4) the web navigation toolbar with a window into which you can type a web address, (5) web page display, and (6) scroll bars.
Update

The Update option allows you to get the most recent updates. The name beside the Update icon will change depending on the status of the most recent update. If a new update is available the name will read “Daily [or Weekly] update is available.” If the latest update has been downloaded, the name will indicate the date (e.g., Updated thru Dec 08).

If an update is available and you would like to have the latest data for your research, please contact a Business Library staff member for assistance.
Market Commentary

The Market Commentary option displays a one-page comment concerning the current market condition. A senior Value Line analyst writes the commentary.

The commentary is accessed by clicking on the Market Commentary icon in the Select Task section of the screen. The commentary is then opened in the display area.
Streaming Real-Time News

The Streaming Real-Time News option displays a list of the latest news stories. The list is updated very frequently throughout the day.

To open the Streaming Real-Time News page click on the **Streaming Real-Time News** icon in the **Select Task** section of the screen.

The Streaming Real-Time news page is opened in the display area. The screen is divided into three sections.

The small section on the upper right of the display area is a welcome message.

The list of news stories is presented in the upper left section of the display area. You may scroll down the list and choose a story. Click on the title and the story will be displayed in the large area below the list.
User’s Manual

The User’s Manual option allows you to access the electronic manual of instructions for *Value Line Investment Survey for Windows®* version 3.0.

To access the User’s Manual option click on the User’s Manual icon in the Select Task section of the screen. The User’s Manual is then opened in the display area using Adobe Acrobat. The Adobe Acrobat controls are included in the display area. The button bar across the top includes various manipulation controls for the document. The status bar across the bottom includes information and controls for the page number of the manual and buttons to control the forward and backward turning of pages.

The manual is designed so that you may go to a particular subject by clicking on the subject line in the bookmark area, which is on the left side of the display. Simply click on the small “+” in the box and the directory tree will expand to display the various topics in the manual. Click on the topic you are interested in and the manual will be opened to that page.
Online Tutorial

The Online Tutorial option allows you to access an electronic tutorial for *Value Line Investment Survey for Windows®*.

To access the Online Tutorial click on **Help** in the menu bar and then **Online Tutorial** in the drop down menu that is displayed.

This opens the Online Tutorial in the display area. The left side of the display area is a directory of topics contained in the tutorial. You may scroll down the directory to select the topic you are interested in studying.

The right side of the display area contains the text and instructions for using the various features available within *Value Line Investment Survey*. The instructions are presented in a step-by-step format with many graphic displays of the actual pages from the database.